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Abstract

Patient-derived organoid (PDO) models of cancer are a multifunctional research system that 

better recapitulates human disease as compared to cancer cell lines. PDO models can be 

generated by culturing patient tumor cells in extracellular basement membrane extracts (BME) 

and plating them as three-dimensional domes. However, commercially available reagents that 

have been optimized for phenotypic assays in monolayer cultures often are not compatible with 

BME. Herein, we describe a method to plate PDO models and assess drug effects using an 

automated livecell imaging system. In addition, we apply fluorescent dyes that are compatible 

with kinetic measurements to quantify cell health and apoptosis simultaneously. Image capture 

can be customized to occur at regular time intervals over several days. Users can analyze drug 
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effects in individual Z-plane images or a Z Projection of serial images from multiple focal planes. 

Using masking, specific parameters of interest are calculated, such as PDO number, area, and 

fluorescence intensity. We provide proof-of-concept data demonstrating the effect of cytotoxic 

agents on cell health, apoptosis, and viability. This automated kinetic imaging platform can be 

expanded to other phenotypic readouts to understand diverse therapeutic effects in PDO models of 

cancer.

Introduction

Patient-derived tumor organoids (PDOs) are rapidly emerging as a robust model system 

to study cancer development and therapeutic responses. PDOs are three-dimensional (3D) 

cell culture systems that recapitulate the complex genomic profile and architecture of 

the primary tumor1 , 2. Unlike traditional two-dimensional (2D) cultures of immortalized 

cancer cell lines, PDOs capture and maintain intratumoral heterogeneity3 , 4, making 

them a valuable tool for both mechanistic and translational research. Although PDOs 

are becoming an increasingly popular model system, commercially available reagents and 

analysis methods for cellular effects that are compatible with PDO cultures are limited.

The lack of robust methods to analyze subtle changes in treatment response hinders clinical 

translation. The gold standard cell health reagent in 3D cultures, CellTiter-Glo 3D, utilizes 

ATP levels as a determinant of cell viability5 , 6. While this reagent is useful for endpoint 

assays, there are several caveats, most notably the inability to use samples for other purposes 

after completion of the assay.

Live-cell imaging is a sophisticated form of kinetic microscopy that, when combined with 

fluorescent reagents, has the capacity to quantify a variety of cell health readouts within 

PDO models, including apoptosis7 , 8 , 9 and cytotoxicity10. Indeed, live-cell imaging has 

been integral to high throughput screening of compounds in 2D platforms11 , 12. Systems 

such as the Incucyte have made the technology affordable and thus accessible to research 

groups in a variety of settings. However, the application of these systems to analyze 3D 

cultures is still in its infancy.

Herein, we describe a method to assess drug response in PDO models of cancer using 

multiplexed live-cell imaging (Figure 1). Through analysis of bright field images, changes 

in PDO size and morphology can be kinetically monitored. Furthermore, cellular processes 

can be simultaneously quantified over time using fluorescent reagents, such as Annexin V 

Red Dye for apoptosis and Cytotox Green Dye for cytotoxicity. The methods presented are 

optimized for the Cytation 5 live-cell imaging system, but this protocol may be adapted 

across different live-cell imaging platforms.

Protocol

Studies using human tumor specimens were reviewed and approved by the University of 

Iowa Institutional Review Board (IRB), protocol #201809807, and performed in accordance 

with the ethical standards as laid down in the 1964 Helsinki Declaration and its later 
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amendments. Informed consent was obtained from all subjects participating in the study. 

Inclusion criteria include a diagnosis of cancer and the availability of tumor specimens.

1. Plating intact PDOs in a 96-well plate

1. Prepare reagents.

1. Preheat 96-well plates at 37 °C overnight and thaw BME overnight at 4 

°C.

2. Prepare full organoid culture media optimized for culturing the cancer 

type of interest. Specific culture media used for experiments shown 

herein are provided in Supplementary Table 1.

NOTE: Media components may need to be modified for different tumor 

types. For example, the organoid culture media is supplemented with 

100 nM estradiol for gynecologic tumors13. Prepared media is stable at 

4 °C for 1 month. For long-term storage, aliquot the media into 50 mL 

tubes and store at −20 °C.

2. Prepare two separate aliquots of organoid culture media at 4 °C and 37 °C. For 

example, if 60 wells are being plated in a 96-well plate, use 6 mL of warm 

organoid culture media and 150 μL of ice-cold organoid culture media.

3. Prepare organoid wash buffer: Supplement 1x PBS with 10 mM HEPES, 1x 

Glutamax, 5 mM EDTA, and 10 μM Y-27632. Store at 4 °C

4. Harvest PDOs cultured in a 24-well plate. Perform all steps on ice or at 4 °C 

unless otherwise noted.

1. Aspirate media from each well using a vacuum line system.

2. Add 500 μL of ice-cold organoid wash buffer and gently pipette 2-3x 

using a 1000 μL pipettor. Incubate the plate on ice for 10 min.

3. Transfer the contents of each well to a 50 mL conical tube. To ensure 

that all the PDOs are in suspension, rinse each well with an additional 

300 μL of organoid wash buffer and transfer to the 50 mL conical tube. 

Centrifuge for 5 min at 350 x g at 4 °C

4. Aspirate the supernatant from the BME/organoid pellet using a vacuum 

line system, leaving ~ 5 mL remaining in the tube. Add 20 mL of 

organoid wash buffer and gently resuspend the pellet using a 10 mL 

serological pipette. Incubate on ice for 10 min.

5. Centrifuge for 5 min at 350 x g at 4 °C. Aspirate the supernatant with a 

vacuum line system, taking care not to disrupt the PDO pellet.

5. Plating PDOs in a 96-well plate: Perform all steps on ice unless otherwise noted.

1. Resuspend the PDO pellet in an appropriate amount of ice-cold 

organoid culture media to create a PDO suspension. Transfer PDO 

suspension to an ice-cold 1.5 mL microcentrifuge tube.
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NOTE: To calculate the amount of organoid culture media, determine 

the number of wells to be plated in a 96-well plate, taking into 

consideration that PDOs are plated in a 5 μL dome in a 1:1 ratio 

of organoid culture media and BME. For example, when plating one 

96-well plate and using only the inner 60 wells, the total amount of 

PDO suspension needed will be 300 μL: 150 μL organoid culture media 

and 150 μL BME. For models that exhibit optimal growth at different 

percentages of BME, the ratio of BME: media may be modified in this 

step, though it is important to standardize the ratio across all assays for 

each specific model. To account for pipetting error, add 10% volume to 

each component.

2. Count the number of PDOs.

1. Transfer 2.5 μL of the PDO suspension to an ice-cold 1.5 mL 

microcentrifuge tube and mix with 2.5 μL of BME. Transfer 

the 5 μL mixture onto a clean glass microscope slide. Do not 

coverslip the slide. The mixture will solidify into a dome.

2. Visualize using a bright field microscope at 4x. Count the 

number of PDOs in the 5 μL mixture; the goal is to have 

roughly 25-50 PDOs per 5 μL dome.

NOTE: If the desired density is not achieved in the test 

mixture, adjust the final volume of the PDO suspension either 

by adding more organoid culture media or centrifuging the 

PDO suspension and resuspending the PDO pellet in a lower 

volume of ice-cold organoid culture media. Regardless of how 

the PDO suspension is modified in this step, the final ratio of 

BME: PDO suspension in step 1.5.3. should be 1:1.

3. Using a 200 μL pipettor with wide bore tips, carefully mix PDO 

suspension with an equal amount of BME to achieve a 1:1 ratio of 

organoid culture media to BME. Avoid bubbles, which will disrupt the 

integrity of the domes.

4. Using a 20 μL pipettor, seed 5 μL domes into the center of each well of 

a prewarmed 96-well plate, seeding only the inner 60 wells. To ensure 

equal distribution of the PDOs, periodically pipet the contents of the 1.5 

mL tube with a 200 μL pipettor with wide-bore tips.

5. After all wells have been seeded, place the lid on the plate and gently 

invert. Incubate the inverted plate at 37 °C for 20 min in the tissue 

culture incubator to allow domes to solidify.

NOTE: Inverting the plate ensures that the BME/organoid culture media 

dome retains the 3D structure to provide adequate room for PDO 

formation.
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6. Flip the plate so that it is sitting with the lid up and incubate for 5 min 

at 37 °C.

2. Treatments and the addition of fluorescent dyes for multiplexing

1. While BME domes are solidifying in the 96-well plates, prepare dilutions 

of fluorescent live-cell imaging reagents. Specific parameters for multiplexing 

Annexin V Red Dye and Cytotox Green Dye are given herein.

2. Fluorescent reagent preparation (Day −1): Calculate the appropriate volume of 

organoid culture media based on the number of wells to be treated, assuming 

each well will be treated with 100 μL of dye-dosed media. Dilute dye in pre-

warmed organoid culture media to the desired concentration.

NOTE: The total amount of media needed will vary depending on the 

experiment. Add 10% to the final volume to account for pipetting error. For 

example, to treat the inner 60 wells of a 96-well plate, prepare 6.6 mL of 

dye-dosed media (Table 1).

3. Treat each well with 100 μL of 2x dye-dosed organoid culture media. Add 200 

μL of sterile 1x PBS to the outer empty wells of the plate. Incubate at 37 °C 

overnight.

NOTE: PBS in the peripheral wells decreases the evaporation of media from the 

inner wells.

4. Addition of drugs/treatment agents (Day 0): Prepare drugs in pre-warmed 

organoid culture media at a 2x concentration in a volume of 100 μL per well.

NOTE: DMSO can be toxic to cells at high concentrations. A concentration of 

0.1% DMSO is not exceeded in the experiments performed in this study. In 

addition to drugs, some fluorescent reagents are distributed as a DMSO solution. 

It is important to account for total DMSO concentration when working with such 

reagents.

5. Add 100 μL of 2x dye-dosed media to each well; avoid creating bubbles.

3. Setting up imaging parameters

1. Place plate in Cytation 5. Open Gen5 software. Click New Task > Imager 
Manual Mode. Select Capture Now and input the following settings: Objective 
(select desired magnification); Filter (select microplate); Microplate format 
(select number of wells); and Vessel type (select plate type). Click Use Lid and 

Use slower carrier speed. Click OK.

NOTE: Vessel Type: Be as specific as possible when selecting information about 

the plate because the software is calibrated to the specific distance from the 

objective to the bottom of the plate for each plate type and thickness of the 

plastic.

Slower Carrier Speed: Select this box to avoid disrupting domes when loading/

unloading plates.
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2. Create a Z-Stack that will image the entire BME dome.

1. Select a well of interest to view (left panel, below histogram).

2. Select the Bright Field channel (left panel, top). Click Auto-expose 
and adjust Settings as needed.

3. Set the bottom and top of the Z-Stack: Expand Imaging Mode tab (left 

panel, middle). Check the Z-Stack box. Using the course adjustment 

arrows (left panel, middle), click the down adjustment until all PDOs 

have come into and then out of focus and are fuzzy. Set this as the 

bottom of the Z-Stack. Repeat in the opposite direction using the course 

adjustment arrows to set the top of the Z-Stack.

4. To ensure that the Z-Stack settings are appropriate for other wells of 

interest, select another well (left panel, below histogram) and visualize 

the top and bottom of the Z-Stack.

5. To manually enter the focal positions, click the three dots next to the 

fine adjustment (left panel, top). A window will open; type in the top 

Z-Stack value (found in the left panel, center, under Imaging Mode). 

Repeat for the bottom Z-Stack value. Adjust as necessary to capture the 

desired Z range by repeating step 3.2.3. If adjustments were necessary, 

select another well to verify settings.

3. Set the exposure settings for the fluorescent channel(s). Settings are described for 

two fluorescent channels (GFP & TRITC). The specific number of fluorescent 

channels will depend on the experiment and which fluorescent cubes are 

installed in the live-cell imaging system.

NOTE: If the signal intensity is anticipated to be significantly higher at the 

end of the experiment, users should consider performing test experiments to 

determine the optimal exposure settings at the end of the experiment that can 

then be applied when setting up the initial parameters.

1. Expand the Imaging Mode tab (left panel, middle) and open Edit 
Imaging Step. A pop-up window will appear.

2. Under Channels, click on the bubble for the desired number of 

channels. Designate one channel for bright field and additional channels 

for each fluorescent channel. In this example, Channel 1 = Bright 

Field; Channel 2 = GFP; Channel 3 = TRITC. Using the drop-down 

Color menus, select the appropriate setting for each channel. Close the 

editing window by clicking OK.

3. Set up each fluorescent channel.

1. Switch the channel to GFP (left panel, top).

2. Click Auto-expose (left panel, top). Expand the Exposure 
tab (left panel, middle) and adjust the exposure settings to 

minimize the background signal.
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3. Copy exposure settings to the Image Mode tab following 

steps 3.3.3.3-3.3.3.6.

4. Click on the Copy icon next to the Edit Imaging Step box. 

Click Edit Imaging Step, which will open another window.

5. Under the GFP channel, click the Clipboard icon in the 

Exposure line to add the Illumination, Integration Time, 
and Camera Gain settings to the channel.

6. Repeat Steps 3.3.3.4-3.3.3.5 for the TRITC channel. Click OK 
to close the window.

4. Set up the image preprocessing and Z-projection steps to automate image 

preprocessing.

1. Click on the Camera icon (left panel, bottom corner). A new window 

will open.

2. Under Add Processing Step (left panel, bottom), click on Image 
Preprocessing. A new window will open.

3. On the Bright Field tab, deselect Apply Image Preprocessing.

4. For each Fluorescent Channel tab, make sure Apply Image 
Preprocessing is selected. Deselect Use same options as channel 1 
and click OK. The window will close.

5. Under Add Processing Step, click on Z Projection. A new window 

will open. If desired, adjust the slice range (e.g., to narrow the Z range). 

Close the window by selecting OK.

5. Create protocol.

1. Click Image Set in the toolbar. In the drop-down menu, click Create 
experiment from this image set. The Imaging Window will close, 

and the Procedure Window will open.

NOTE: The parameters selected in Imager Manual Mode will 

automatically be loaded into the new window, whereby an experimental 

protocol can be created.

2. Set the temperature and gradient: Click Set Temperature under the 

Actions heading (left). A new window will open. Select Incubator On 
and manually enter the desired temperature under Temperature. Next, 

under Gradient, manually enter 1. Close the window by selecting OK.

NOTE: Creating a 1 °C gradient will prevent condensation from 

forming on the lid of the plate.

3. Designate wells to the image.
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1. Double-click on the Image Step under Description. Click 

Full Plate (right corner, top). This will open the Plate Layout 
window.

2. Highlight wells of interest using the cursor. Click OK. If 

desired, check Autofocus Binning and Capture Binning 
boxes. Click OK to close the window.

NOTE: Binning will require exposure adjustment, as described 

in step 3.3.3.2 above. Please refer to the Discussion section for 

specific scenarios in which this feature may be used.

4. Set intervals for kinetic imaging.

1. Click on Options under the Other heading (left). Check the 

Discontinuous Kinetic Procedure box.

2. Under Estimated Total Time, enter the run time for the 

experiment (e.g., 5 days). Under Estimated Interval, enter 

the interval to image the plate (e.g., every 6 h).

3. Click Pause after each run to allow time for the plate to be 

transferred to the incubator. Close the window by selecting 

OK.

5. Update data reduction steps.

1. Click OK to close the Procedure Window. A tab will open 

to update data reduction steps. Select Yes. Double-click on 

Image Preprocessing. Click through the different channels to 

verify settings and click OK.

2. Double-click on Z Projection. Click through the different 

channels to verify settings. Click OK. Then, click OK again to 

close the Data Reduction Window.

6. Format the plate layout.

1. Open the Plate Layout Wizard and designate well types 

following steps 3.6.2-3.6.3.

2. Click on the Plate Layout icon in the toolbar (left corner, top) 

to open the Plate Layout Wizard.

3. Check the boxes next to the well types used in the experiment. 

Under Assay Controls, enter the number of different control 

types using the arrows. Click Next to open the Assay Control 
#1 window.

4. Set assay control well conditions following steps 3.6.5-3.6.8.

5. On the Assay Control #1 window, enter the control label in 

the Plate Layout ID box. If desired, enter the full name in the 
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adjacent box. Select the number of replicates for the respective 

control condition using the arrows.

6. If using multiple concentrations or a dilution series within 

the control, click Define dilutions/concentrations and use the 

drop-down menu to select the Type. Enter values for each 

concentration/dilution in the table.

NOTE: The auto function can be used if concentrations 

change by a consistent increment.

7. Select the Color tab in the toolbar. Choose desired text color 

and background color for control in the drop-down menu. 

Click Next.

8. Repeat as necessary with additional controls.

9. Set sample well conditions following 3.6.10-3.6.12.

10. On the Sample Setup page, enter the sample ID Prefix (e.g., 

SPL). Select the number of replicates using the arrows. If 

using samples with varying treatment concentrations, select 

Concentrations or Dilutions in the Type dropdown menu. 

Enter dilutions/concentrations in the table and enter units in 

the Unit box.

11. Select Identification Fields in the toolbar. Enter the desired 

Category Name(s) (e.g., sample ID, drug) in the table.

12. Select the Color tab in toolbar. Select a different color for 

each treatment group/sample. Click Finish. This will open the 

Plate Layout page.

NOTE: The numbers on the left side correlate with the 

different sample numbers.

13. Assign Sample IDs following steps 3.6.14-3.6.16.

14. Select SPL1 from the left panel. Use the cursor to select wells.

NOTE: Autoselect tools can be adjusted in the serial 

assignment box. The number of replicates and orientation of 

the layout can be pre-designated.

15. Repeat with other samples to complete the plate layout. Once 

satisfied, click OK.

16. In the File toolbar, select Sample IDs. Fill in Sample ID 
columns with the appropriate information for each sample 

(e.g., drug type). Press OK.

7. Save the protocol.
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1. In the toolbar, click File > Save Protocol as. Select the 

location to save the file. Enter a file name. Click Save to close 

the window.

2. Click File > Exit in the toolbar. A tab will open to save 

changes to Imager Manual Mode. Select No.

3. A tab will open to save changes to Experiment 1. Select No. A 

tab will open to update the protocol definition. Select Update. 

Close the software.

6. Import the protocol into BioSpa OnDemand and finish setting up the 

Experiment.

1. Open the BioSpa OnDemand (scheduling software) software.

2. Select an available slot in the software.

3. Remove the plate from the live-cell imaging system. Click Open 
Drawer to access the appropriate slot in the scheduling software and 

insert the plate. Click Close Drawer.

NOTE: This step can be performed at any point once the protocol has 

been created in step 3.5.7 above. However, the plate must be in the 

Cytation 5 to perform a timing run in the below Step 3.6.4.3.

4. Import the Protocol.

1. Under the Procedure Info tab, select User in the drop-down 

menu. Next to the Protocol slot, click Select > Add a new 
entry.

2. Next to the Protocol slot, click Select. This will open a 

new window to navigate to the desired Protocol in the file 

architecture. Click Open to import the Protocol into the 

scheduling software.

3. Enter the amount of time needed to image the plate. Click OK 
to close the Gen5 Protocol List window.

NOTE: This step is especially important when running several 

experiments at a time. To determine the time needed to image 

the, click Perform a timing run now. Click OK.

5. Set imaging intervals and schedule the experiment.

1. Under Interval, enter the imaging interval designated in step 

3.5.4.

2. Under Start Time Options, select When Available. Under 

Duration, select Fixed or Continuous.

NOTE: A specific start time can be designated instead of 

running the protocol at the next available time. Selecting 
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Fixed Duration will set a specific endpoint for the experiment 

and requires the user to designate an experimental timeframe. 

Continuous Duration will allow the experiment to run with 

no endpoint and can only be ended by a user stopping the 

experiment.

3. Click Schedule Plate/Vessel. This will open the Plate 

Validation Sequence. A tab will open with the proposed first 

read time. Click Yes to accept this schedule.

4. Image analysis in Gen5 software(Figure 2)

1. Open Image Analysis module.

1. Open Gen5. In the Task Manager, select Experiments > Open. Select 

the experiment to open the file. Click Plate > View in the toolbar.

2. Change Data drop-down menu to Z Projection. Double-click on a well 

of interest. Select Analyze > I want to setup a new Image Analysis 
data reduction step. Click OK.

2. Cellular analysis

1. Primary mask

1. Under Analysis Settings, select Type: Cellular Analysis and 
Detection Channel: ZProj[Tsf[Bright Field]] (left panel, 

center).

2. Click Options. This will open the Primary Mask and Count 
page. In the Threshold box, check Auto and click Apply. 

Click the Highlight Objects box (right panel, bottom) to show 

objects within the designated threshold. Adjust as necessary to 

include objects of interest.

NOTE: Threshold settings are based on pixel intensity. For 

example, if the threshold is set to 5000, pixels with an 

intensity greater than 5000 will be included in the analysis.

3. Under Object Selection, designate the minimum and 

maximum object size (μm). Adjust as necessary to exclude 

cellular debris/single cells.

NOTE: PDO size may vary significantly between different 

models and types. Use the measuring tool in the Gen5 

software to determine the minimum and maximum PDO 

size thresholds for each model. Users may choose a smaller 

minimum PDO size threshold relative to the value provided by 

the measuring tool in order to prevent the exclusion of PDO 

fragments at later time points after drug treatment.
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4. To limit the analysis to a certain region of the well, deselect 

Analyze entire image and click Plug. In the Image Plug 
window, use the dropdown menu to select Plug shape. Adjust 

the size and position parameters as necessary to fit the region 

of interest.

NOTE: It is important to maximize the number of PDOs 

within the plug while also excluding PDO-free areas to 

minimize background. Designate a plug size that will 

consistently capture the majority of the objects of interest 

across replicates. Generating a plug that also excludes the 

edges of the dome is important as it excludes any objects 

that may appear distorted due to the refraction of light from 

the extreme curvature of the dome around the edges. Include 
primary edge objects may also be deselected to capture only 

entire PDOs within the plug.

2. Subpopulation analysis. An example of subpopulation designation is 

provided in Figure 3.

1. Click on Calculated Metrics in the Cellular Analysis toolbar. 

Click Select or create object level metrics of interest 
(right corner, bottom). Under Available Object metrics, select 

metrics of interest (e.g., circularity) and click the Insert 
button. Click OK.

NOTE: The morphology and density of each PDO model 

will determine the best metrics of interest to distinguish the 

subpopulation.

2. Click on Subpopulation Analysis in the Cellular Analysis 
toolbar. Click Add to create a new subpopulation. A pop-up 

window will open.

3. If desired, enter a name for the subpopulation. Under Object 
Metrics, select a metric of interest and press Add Condition. 

In the Edit Condition window, enter parameters for the 

chosen Object Metric. Repeat with additional metrics as 

necessary.

NOTE: Parameters may be adjusted manually or set using the 

finder tool. For example, to exclude debris, users could add 

Area as an Object Metric and select objects smaller than 800. 

Circularity as an Object Metric is routinely used, and any 

objects with a circularity greater than 0.2-0.5 are included, 

depending on the model.

4. In the table at the bottom of the window, check the desired 

results to display. Click OK > Apply.
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5. To view the objects within the subpopulation, use the Object 
Details drop-down menu (right panel, center) to select the 

subpopulation. Objects that fall within the parameters will be 

highlighted in the image.

NOTE: To change the highlight colors of the primary mask 

and subpopulation, click Settings (right panel, bottom).

6. To adjust subpopulation parameters, reopen the 

Subpopulation Analysis window from the Cellular Analysis 
toolbar. Select the subpopulation and click Edit. Click Add 
Step.

NOTE: This will apply the same analysis to all wells within 

the experiment at all time points. In the drop-down menu 

on the Matrix page, different metrics can be selected for 

individual viewing.

5. Exporting data from Gen5 to Excel

1. To customize a data file for export, select the Report/Export Builders icon in 

the toolbar. In the pop-up window, click New export to Excel.

2. On the Properties page of the pop-up window, select Scope > Plate and 
Content > Custom. Click on the Content option in the toolbar. Click Edit 
Template, which will open the Excel program.

3. Within the spreadsheet, select Add-ins > Table > Well Data. Hover over the 

various selections to see options for export. Select metric of interest (e.g., Object 

Mean[ZProj[Tsf[TRITC]]]).

NOTE: Plate layout can be added to the spreadsheet analysis template by 

selecting Add-ins > Protocol Summary > Layout.

4. An Edit window will open. In the Wells box, designate the wells for export 

either by Well-ID or Well #. Select OK. A template will be loaded into the 

spreadsheet file. Close spreadsheet. The template is automatically saved.

5. Click OK on the New export to Excel window and close the Report/Export 
Builders window.

6. Click the Export icon in the Gen5 toolbar. Check the box next to the desired 

export file. Click OK. Gen5 will automatically populate the spreadsheet template 

and open the file in Excel.

6. External data analysis

1. Open the Export file (.xlsx) in Excel.

2. For each well, divide each individual value by the 0:00 time point value for that 

well. This will set time point 0 equal to 1, and each value beyond that will be 

relative to the initial reading.
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3. Open a new file in the data analysis software. Select the XY layout option.

NOTE: In this protocol, GraphPad Prism (version 9.5.1) was used.

4. Input labels for each data group. Copy and paste the time points and 

corresponding normalized values for each treatment group into the Prism table. 

A graph for the data will be automatically generated and can be found under 

Graphs.

Representative Results

Our objective was to demonstrate the feasibility of using multiplexed live-cell imaging 

to assess PDO therapeutic response. Proof of concept experiments were performed in 

two separate PDO models of endometrial cancer: ONC-10817 and ONC-10811 (see 

Supplementary Figure 1 and Supplementary Figure 2 for ONC-10811 data). Apoptosis 

(annexin V staining) and cytotoxicity (Cytotox Green uptake) were kinetically monitored in 

response to the apoptosis-inducing agent, staurosporine. Specifically, PDOs were plated in 

96-well plates, treated with Annexin V Red and Cytotox Green dyes, and placed in a 37 

°C incubator overnight as diagrammed in Figure 1. We confirmed in two independent PDO 

models that treatment with Annexin V and Cytotox Green dyes is not toxic (Supplementary 

Figure 2). The following day, PDOs were treated with increasing concentrations of 

staurosporine (0.01 nM, 0.1 nM, 1 nM, 10 nM, 100 nM, 500 nM). Subsequently, protocols 

were established in the Gen5 software and experiments were set to run over a period 5 days, 

imaging every 6 h. Data were analyzed using the Cellular Analysis function in the Gen5 

software as described in section 4 of the protocol. The Primary Mask was set using the 

Auto threshold function with "Split touching objects" unchecked and with size parameters 

of minimum: 30 μm and maximum: 1000 μm. The PDO subpopulation was defined by 

circularity > 0.25. The Object Mean Intensities in the TRITC (annexin V, apoptosis) and 

GFP channels (Cytotox Green, cytotoxicity) within the designated PDO subpopulation were 

exported as an .xlsx file for further analysis. The Object Mean Intensity for each well at 

each time point in both the GFP and TRITC channels was normalized to time 0. Normalized 

fluorescence data were then transferred to a Prism file and visualized as a line plot.

Treatment with staurosporine resulted in a significant, dose-dependent increase in apoptosis 

and a decrease in cell health over time in comparison to vehicle control, as evidenced 

by the increase in Object Mean Intensity in both the TRITC (annexin V) and GFP 

(Cytotox) channels (Figure 4, Figure 5, Supplementary Video 1, Supplementary Video 2, 

Supplementary Video 3, Supplementary Video 4, Supplementary Video 5, Supplementary 

Video 6, and Supplementary Video 7). The 500 nM, 100 nM, and 10 nM doses of 

staurosporine each resulted in a statistically significant increase in both apoptosis and 

cytotoxicity over time (Figure 5A-C) as well as at the end of the experiment (Figure 

5E,F). Furthermore, staurosporine effectively inhibited PDO growth and formation at these 

concentrations, as demonstrated by an overall decrease in total PDO area, whereas the 

control wells exhibited an increase in total PDO area (Figure 4 and Figure 5D).

Since a major advantage of live-cell imaging is the ability to correct for variability in plating, 

we performed an experiment whereby cell viability was assessed as an endpoint measure. 
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Proof-of-concept endpoint assay data were collected using a PDO model that was generated 

from a patient-derived xenograft of prostate cancer. Bright field images were collected at 

the beginning of the treatment period (day 0), followed by addition of a dual dye reagent 

that measures both viability (acridine orange, AO) and cell death (propidium iodide, PI). The 

AO component emits a green fluorescent signal upon binding to double stranded DNA, an 

indicator of cell viability. The PI component stains dead nucleated cells and can be used 

to quantitate cell death in response to treatment. In order to account for variability in PDO 

plating, we devised a method to determine the number of PDOs per well at time 0 by 

converting bright field images to Digital Phase Contrast images (Supplementary Figure 3 

and Supplementary File 1).

Prostate cancer PDOs were treated with daunorubicin, a chemotherapy agent that causes 

cell death, for 7 days. Upon completion of the experiment, samples were stained with 

AOPI as described in Supplementary File 1, followed by analysis of fluorescent images in 

Gen5. Figure 6A shows a panel of images from the AOPI endpoint assay on day 7. When 

comparing vehicle-treated PDOs (row one) to PDOs treated with 10 μM daunorubicin (row 

two), there was a clear decrease in green fluorescence (measure of viability, column two) 

and an increase in red fluorescence (measure of cell death, column three). These results were 

then quantitated in Figure 6B, where we show the array of readouts that can be achieved 

using the AOPI endpoint staining technique. The upper left plot depicts the viability 

measurement generated from the AO stain, normalized to the PDO count determined by 

Digital Phase Contrast image analysis of each well on Day 0. These data correlate with the 

visual result from Figure 6A, whereby as the concentration of daunorubicin increased, the 

viability drastically decreased. This is further recapitulated in the upper right graph, which 

demonstrates an increase in cell death denoted by an increase in red fluorescence acquired 

with the PI stain.

The PI data were then combined with the viability reading (AO) to calculate a Viable to 

Dead Ratio (Figure 6B, lower left graph). This ratio is a useful approach to determine 

whether a drug is cytostatic or cytotoxic. Specifically, a cytotoxic drug will reach much 

closer to 0 than a cytostatic drug due to the fact that a drug that is cytostatic will 

inhibit growth but may not induce cell death. Lastly, the area of the PDOs can be 

accurately calculated using the green fluorescence of the AO stain, even when PDOs may 

be undergoing cell death and blebbing. The lower right graph depicts the average PDO 

area, which was calculated as the sum of the area denoted in the subpopulation analysis 

divided by the PDO number. Analysis of the area can give further indication as to whether 

a treatment is simply inhibiting PDO growth or actually causing PDO regression. Note that 

the analysis of the average PDO area was performed using the GFP channel and Cellular 

Analysis function, in contrast to Figure 5D, which used the bright field images to calculate 

total PDO area. These data highlight the flexibility of the analysis pipeline depending on 

data availability and user interest.

Finally, we compared the gold standard for viability readings, CellTiter-Glo 3D, to the 

viability fluorescence reading using AOPI (Figure 6C). Note that the data in this panel 

were not normalized to the time 0 PDO number since this normalization is not typically 

performed by labs using the CellTiter-Glo 3D kit. We observed the same trend for drug 
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effect in both assays, whereby PDO viability decreased as the daunorubicin concentration 

increased. The only visual difference between these readouts was that the CellTiter-Glo 

3D analysis reached an IC50 before the AOPI analysis and nearly completely reached 0. 

This result may be explained by the mechanism of action of daunorubicin. Daunorubicin 

is a topoisomerase-II inhibitor that introduces double-stranded DNA breaks, leading to cell 

cycle arrest and eventually apoptosis14. During cell cycle arrest, ATP depletion can occur15. 

Given that the CellTiter-Glo 3D assay is based on an ATP-luciferase reaction to generate a 

luminescence signal, we hypothesize that the stronger reduction in cell viability at higher 

concentrations of daunorubicin was due to ATP depletion rather than complete cell death. 

Supporting this idea, the images in Figure 6A depict a population living PDOs in the culture, 

as denoted by green fluorescence.

Discussion

PDO cultures are becoming an increasingly popular in vitro model system due to their 

ability to reflect cellular responses and behaviors2. Significant advances have been made 

in PDO generation, culture, and expansion techniques, yet methods to analyze therapeutic 

responses have lagged. Commercially available 3D viability kits are lytic endpoint assays, 

missing out on potentially valuable kinetic response data and limiting subsequent analyses 

by other methods8. Emerging studies are applying live-cell imaging to assess drug responses 

in PDO models. Here, we present a method to assess PDO therapeutic responses over time 

utilizing multiplexed fluorescent live-cell imaging. Multiplexing fluorescent dyes allows for 

different cellular responses to be quantified simultaneously. In addition to apoptosis and 

cytotoxicity, we envision that this approach can be expanded in future studies to examine 

other phenotypic effects in PDOs.

The protocol presented herein is designed to acquire kinetic bright-field and fluorescent 

images of PDOs plated as domes in a 96-well plate. Key steps include 1) plating, 2) treating 

with dye and drug, 3) defining imaging parameters, 4) image preprocessing and analysis 

at the completion of kinetic image acquisition, and 5) data export for analysis in other 

statistical software (Figure 1). Intact PDOs are plated in a 96-well plate as 5 μL BME 

domes composed of a predefined ratio of BME and Organoid Culture Media (typically 1:1). 

The protocol presented herein uses UltiMatrix as the BME due to minimal batch-to-batch 

variability and superior optical properties for imaging. Modifications for harvesting PDOs 

cultured in other BMEs, such as Matrigel, may be necessary, as well as for models that are 

clumpy and difficult to dissociate (see examples Supplementary Figure 4). Next, fluorescent 

dyes are added to the Organoid Culture Media at the time of plating (Day −1) at a 2x 

concentration in a 100 μL volume and incubated overnight to determine baseline cell death. 

The following day (Day 0), drugs or other treatments are added to Organoid Culture Media 

at a 2x concentration in a 100 μL volume, and then added to each well for a final volume 

of 200 μL. The final volume of 200 μL reduces the meniscus effect with imaging. Kinetic 

images are acquired using the Cytation 5 plate reader partnered with the BioSpa tabletop 

incubator. The BioSpa incubator allows for the incubation of experimental plates at a fixed 

temperature of 37 °C and 5% CO2 environment. Up to 8 plates can be stored in the BioSpa 

and thereby, 8 experiments can be simultaneously conducted. Imaging parameters for each 

plate are set up in the Gen5 software using "Imager Manual Mode" and saved as a Protocol. 
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The Protocol is then loaded into the scheduling software (BioSpa OnDemand). The BioSpa 

OnDemand software automates the workflow for kinetic image acquisition, including the 

physical transfer of the plate from the BioSpa incubator into Cytation 5 and dictating 

which protocol to run in Gen5 for data collection. Images are analyzed using the Cellular 

Analysis function in the Gen5 software (Figure 2). We describe specific methods to analyze 

Z Projections of fluorescent and bright field images. Specific methods to analyze single 

Z planes and/or only bright field images are provided in Supplementary File 1. Finally, 

users can define specific data features, such as PDO area, number, and mean fluorescence 

intensity, to export as an Excel spreadsheet for subsequent statistical analysis of drug effects.

Given that PDO models are a relatively new model system to interrogate drug effects, 

methods to accommodate the culture conditions, in particular growth in BME, are still 

emerging16. The bulk of studies assessing PDO response to drug treatment rely on ATP-

based endpoint assays as a surrogate for cell health (CellTiter-Glo 3D). This method 

requires cell lysis, thus precluding subsequent downstream analyses. Alternative endpoint 

assays, such as fluorescent staining, single timepoint imaging, and morphologic tracking, 

have provided other metrics to characterize drug response while allowing for sample 

use for additional purposes. For example, in-plate endpoint fixation protocols have been 

applied for high-throughput analysis of drug effects17 , 18. An advantage of this method 

is that it circumvents the extensive processing required in typical immunohistochemistry 

and immunofluorescent imaging19 and is particularly useful when sample is limited, as is 

the case for PDO models. It is also amenable to high-resolution imaging with confocal 

microscopy. Another endpoint assay that does not require cell lysis is live-cell imaging 

with reagents such as propidium iodide or acridine orange. Our comparative analysis of 

CellTiter-Glo 3D and AOPI, the latter of which does not require cell lysis, for assessment 

of cell viability and death (Figure 6C) highlights the advantages of using live-cell imaging 

dyes in PDO models. This method has been applied by several groups, including ours, to 

assess phenotypic effects at the conclusion of an experiment18 , 19 , 20. However, kinetic 

data acquisition using either the in-well fixation or endpoint live-cell imaging methods 

requires significant sample. Label-free morphologic assessment of PDOs over time in part 

overcomes this limitation and can be assessed using a wide range of imaging modalities8 , 

10 , 17 , 18, yet changes in morphology may not be representative of the spectrum of potential 

drug effects such as apoptosis and changes in cell viability. We have observed significant 

model-to-model variability in morphologic changes in response to drugs. For example, some 

PDOs will increase in area as they are undergoing apoptosis, whereas other models may 

shrink. Kinetic morphologic assessments have been multiplexed with either fixed or live-cell 

fluorescent endpoint assays in a limited number of studies18 20. The methods presented 

herein are among the first to multiplex different fluorescent dyes to simultaneously assess 

multiple cellular effects in a high-throughput system.

One of the greatest improvements provided by kinetic live-cell imaging is that it overcomes 

key limitations associated with endpoint assays. For example, plating an equal number of 

PDOs per well is technically difficult because most automated cell counters are gated for 

objects smaller than 60 μm. Live-cell imaging allows for normalization to PDO number or 

area at time 0 h in each well, which can then be used to adjust for variation in plating 

amongst wells. The gold standard endpoint assay for PDOs is the CellTiter-Glo 3D kit, 
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which measures ATP as a surrogate for cell viability. We have extensively used this assay 

in our studies of gynecologic and prostate cancer PDOs13 , 21 , 22 , 23 , 24. In addition to 

requiring cell lysis for ATP measures, drugs and other therapeutic modalities can alter ATP 

levels, potentially providing an inaccurate assessment of therapeutic response. Utilizing live-

cell imaging dyes allows for quantification of a wider scope of specific cellular responses, 

such as apoptosis and cytotoxicity. Importantly, these reagents do not perturb cell viability 

or induce DNA damage, as is the case with propidium iodide; this allows for repeated 

assessment of PDO response over time. While we have not explored the use of acridine 

orange (AO) for kinetic measures, the mechanism of action for AO should not preclude such 

application in the future.

Tumors consist of several distinct cell populations with varying genomic profiles and 

morphologies. Due to the complex heterogeneity of PDO models, individual PDO responses 

may vary, and tracking these responses is challenging. Our protocol provides a method to 

assess multiple PDO response metrics on a well-by-well basis. However, certain technical 

considerations still apply to livecell imaging. The number of wells of a 24-well plate 

needed to seed a 96-well plate will depend upon the density and growth rate of each PDO 

model. Because clumping can confound image analysis (Supplementary Figure 4), PDO 

models may need additional processing steps prior to plating. If necessary, PDOs may be 

mechanically sheared during processing through vigorous pipetting with a non-wide bore 

p200 tip. Enzymatic digestion using TrypLE Express may also be employed prior to plating 

to promote PDO dissociation and decreased clumping. In our experience, we have noted that 

the length of TrypLE incubation is highly variable depending upon the model. Therefore, 

TrypLE incubation should be optimized for each model, particularly if researchers wish to 

obtain single cell suspensions. Recovery time prior to beginning treatment may be necessary 

for PDO models that are particularly sensitive to enzymatic digestion.

We present methods for specific live-cell imaging reagents. A limitation in the broad 

applicability of the methods presented herein is a paucity of reagents that are compatible 

with BME. For other dyes/reagents that have not yet been optimized for use in PDOs, 

additional troubleshooting may be necessary to determine the optimal concentration 

and minimize solvent effects. Depending on the readout of interest (e.g., apoptosis 

or cytotoxicity), treatment with a compound known to induce cell death, such as 

staurosporine or daunorubicin13 should be used to optimize reagent conditions. An 

additional consideration is the optimal time for dye integration into the BME dome. In our 

experiments, we perform an overnight incubation prior to treatment to allow for complete 

uptake of the dye into the domes as well as determine baseline cell health. Since signal 

intensity will increase over time, researchers should perform pilot studies with the dyes 

to determine the ideal exposure time at the end of the experiment to avoid overexposed 

images. Finally, reagents should not interfere with cellular processes. For example, dyes 

that intercalate into DNA are not compatible with kinetic imaging. However, live-cell 

imaging can be used for data normalization in endpoint assays. Indeed, we present a 

supplementary method to quantify cell viability and the viable: dead cell ratio using AOPI. 

In this experiment, the fluorescent signal is normalized to PDO number for each well as 

determined by live-cell imaging on day 0 (day of treatment, Figure 6).
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Another limitation of this methods paper is the reliance on manual pipetting for experiments, 

which can lead to greater variance in technical replicates. Further improvements in data 

reproducibility can be achieved with the addition of automation to other steps of the 

experimental process, such as the use of an automated liquid handler for plating and drug 

dispensing, as has been demonstrated by others8 , 10. However, this addition requires an 

additional investment in research infrastructure that may not be available to all investigators. 

Given the heterogeneity in PDO area for each model, normalizing results to the initial PDO 

number or area at time 0 h is still a useful approach with automated seeding.

A key advantage of Cytation 5 over other live-cell imaging platforms is the ability to 

customize image and analysis features. However, the Cytation 5/Gen5 software has a steep 

learning curve and assumes that users have a foundational knowledge of imaging. One of 

the goals of this methods paper is to provide step-by-step instructions to decrease the barrier 

for other researchers to incorporate sophisticated livecell imaging techniques in their PDO 

research programs. While the specific analysis steps presented herein are for one system, 

users can apply the multiplexing principles to other platforms, with the understanding that 

downstream analysis may necessitate the use of third-party software, such as NIH ImageJ.

Analysis metrics should be chosen based on both experimental goals and plating conditions. 

For example, if the experiment is conducted using a fluorescent dye to quantify cell 

death, fluorescence intensity is an effective readout. The most effective fluorescence metric 

(Total Fluorescence vs. Object Mean Intensity) will depend on the plating conditions 

(Supplementary Figure 4). If PDOs are evenly dispersed and have a more circular, cohesive 

morphology, fluorescence can be determined in a defined PDO subpopulation. The specific 

function in the Gen5 software is Cellular Analysis, and the output is Object Mean Intensity. 

However, if the PDO model is clumpy or has a discohesive morphology, we recommend 

quantifying the fluorescence signal at the image level; this function can be found under 

Image Statistics, and the output is Total Fluorescence Intensity. While this method is useful 

for observing changes at the individual well level, this metric is not specific for objects 

of interest and could change erroneously if the PDOs move outside of the designated plug 

over the duration of the experiment. In scenarios in which there is significant debris or dead 

single cells, use of the Cellular Analysis is suggested to gate out any fluorescent signal that 

is not specifically associated with a PDO. An example of differential results using Cellular 

Analysis vs. Image Statistics is presented in Supplementary Figure 5.

To determine the optimal threshold for the Image Statistics function, the line tool may be 

utilized. Using the line tool, users can determine the range of fluorescence intensity within 

an image. We set the lower threshold as the 25% value of the peak intensity within the 

image. To view the fluorescent areas that are included in the designated threshold, check 

the "Threshold Outliers" box. Additional fine-tuning of the lower threshold value may be 

necessary.

A significant challenge in live-cell imaging is storing the massive amount of data generated 

with each experiment. This is particularly relevant in the case of PDO cultures, where 

Z-Stacks are used to image across several focal planes and generate a Z Projection. There 

are multiple methods to overcome this issue. First, ensure adequate storage capacity. We 
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have installed three solid-state hard drives with a total of 17 TB. Other options include 

transferring experimental files to external hard drives or networked storage. It is not 

recommended to directly write files to cloud based storage. To analyze data that has 

been stored on an external drive, simply transfer the experiment and the image files to a 

computer equipped with Gen5 software (NOTE: large files may take extended periods of 

time to transfer). Before analysis, the images must be relinked to the experiment. Open the 

experiment file, click Protocol in the toolbar, select Protocol Options. Click Image Save 

Options and click Select new image folder. Locate the image file and click Select Folder to 

relink.

Depending on the goals of the experiment, it may also be suitable to use the binning feature 

within Gen5. Binning decreases file size by lowering the number of pixels, which leads 

to lower image resolution (see step 3.5.3.2). Therefore, binning is not recommended if 

high-resolution images are required. When using the binning feature, the exposure settings 

will need to be adjusted. Once the experimental file has been created, double click on the 

Image section, and click the microscope icon to reopen Imager Manual Mode. Use the 

Auto-expose function or manually adjust exposure as needed.

In summary, we present methods for assessing apoptosis and cell health of PDOs in response 

to cytotoxic agents. Future studies are necessary to optimize methods and develop additional 

analysis strategies for kinetic imaging of PDOs, such as other phenotypes and effects 

of drugs that are cytostatic rather than cytotoxic. A major roadblock is the commercial 

availability of dyes and reagents that are compatible with BME. There is still more work 

necessary to better understand how kinetic live-cell imaging can be fully utilized to extract 

the most data from these models.

Supplementary Material

Refer to Web version on PubMed Central for supplementary material.
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Figure 1: Overview of plating, imaging, and analysis protocol.
PDOs are plated in a 96-well plate and treated with fluorescent dyes and drugs. Imaging 

parameters for the experiment (e.g., Exposure, Z-stack) are created in the Gen5 software. 

Images are acquired by the Cytation 5 and processed in Gen5, and data are exported for 

further analysis.
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Figure 2: Overview of Cellular Analysis feature.
1: Designate Plug: A plug is designated to include areas of interest. 2: Set Primary Mask: 

The Primary Mask defines objects of interest based on size and pixel intensity in a channel 

of choice. In this representative image, objects included in the primary mask are outlined 

in purple. 3: Define Subpopulation: An additional subpopulation may be defined to further 

refine the desired population for analysis. The subpopulation in the example image (outlined 

in yellow) is defined based on circularity (>0.25) and area (>800). Images were acquired 

with a 4x objective.

Colling et al. Page 23

J Vis Exp. Author manuscript; available in PMC 2024 July 18.

A
uthor M

anuscript
A

uthor M
anuscript

A
uthor M

anuscript
A

uthor M
anuscript



Figure 3: Examples of subpopulation masking using the Cellular Analysis feature.
Subpopulations are defined in the bright field channel. The subpopulation in the example 

images (outlined in yellow) is defined based on circularity (>0.25) and area (>800). Images 

were acquired with a 4X objective.
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Figure 4: Staurosporine treatment results in a dose-dependent increase in apoptosis and 
cytotoxicity.
Bright field images (4x objective) with GFP and TRITC fluorescence overlay are shown for 

the 500 nM, 10 nM, and 0.1 nM doses of staurosporine at 3 time points: 0 h, 54 h, 114 h. 

The red fluorescent signal indicates apoptosis (annexin V), and the green fluorescent signal 

indicates cytotoxicity (Cytotox).
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Figure 5: Multiplexed fluorescent live-cell imaging to assess PDO response.
PDO model ONC-10817 was plated in 96-well plates and incubated with Annexin V Red 

(1:400), and Cytotox Green (200 nM) dyes overnight at 37 °C. The following day, PDOs 

were treated with increasing concentrations of staurosporine and were imaged every 6 h 

for ~5 days. (A,B) Time and dose-dependent increase in (A) cytotoxicity or (B) apoptosis 

in response to staurosporine. Data were plotted as the Object Mean Intensity in the GFP 

or TRITC channel. (C) Comparison of the time course of apoptosis and cytotoxicity in 

response to 100 nM or 500 nM staurosporine. Data were plotted as the Object Mean 

Intensity values in the GFP and TRITC channels. (D) Staurosporine inhibits growth of 

PDOs. Data were plotted as the average total PDO area. Data in A-D were normalized to 

PDO number at time 0 h in each well and plotted as the mean and standard error of the 

mean (SEM). N=5 technical replicates per treatment. **** p < 0.0001 vs. vehicle control 

by 2-way ANOVA. (E) Representative bright field, GFP, and TRITC images of 500 nM 

staurosporine-treated PDOs vs. vehicle at the end of the experiment (114 h). Images were 

acquired with a 4x objective. (F) Quantification of cytotoxicity, apoptosis, and viability at 

the 114 h time point. GFP Object Mean Intensity (left) and TRITC Object Mean Intensity 

(middle) were calculated at the 114 h timepoint using results from panels A-C. Viability 

(right) was assessed using the CellTiter-Glo 3D reagent per the manufacturer's protocol. 

Raw luminescence (RLU) values were normalized to total PDO area at time 0 h and plotted 

as the fold viability relative to vehicle control, which was set at 1.0. ** p<0.01, ***p<0.001, 

**** p<0.0001 vs. vehicle control via one-way ANOVA with Dunnett's post-hoc test. N = 5 

technical replicates per treatment.
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Figure 6: Use of live-cell imaging to aid in the normalization of endpoint assay data.
PDOs were treated with increasing concentrations of the topoisomerase-II inhibitor, 

daunorubicin, for 7 days. PDOs were exposed to AOPI Staining Solution and imaged 

as described in Supplementary File 1. AO = acridine orange, a measure of viability 

(GFP channel); PI = propidium iodide, a measure of cell death (Texas Red channel). (A) 

Representative images acquired using AOPI staining after 7 days of treatment with 10 

μM daunorubicin or vehicle control (0.1% DMSO). (B) Different readouts using AOPI 

fluorescence as an endpoint viability/cell death method. See Supplementary File 1 for a 

detailed description of the analysis methods. Upper left, analysis of PDO viability after 7 

days as determined by AO staining. Upper right, analysis of cell death by PI staining. Data 

for AO and PI staining were normalized to PDO number at time 0 h and then to vehicle 
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control, which was set at 1.0, and plotted as the mean and standard deviation. Lower left, 

calculation of viable to dead ratio using the average object integrals for the AO and PI stains. 

Lower right, area of PDOs as determined by AO staining. Cellular Analysis was performed 

in the GFP channel. (C) Comparison of two methods to test PDO viability. After imaging, 

viability was evaluated using the CellTiter-Glo 3D reagent per the manufacturer's protocol. 

The fold survival relative to vehicle control was plotted at increasing concentrations of 

daunorubicin. Data represent the mean and standard deviation for N = 6 technical replicates 

per treatment; data were not normalized to time 0 h in panel C.
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